Multiframe v7.0 Release Note

Multiframe 7.0 25" January 2000
Release Note

This release note describes the Windows 95/98 /NT Version 7.0 of
Multiframe, Steel Designer and Section Maker. This release contains
numerous enhancements for each of these products.
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Multiframe

The following features have been modified or added to Multiframe in
this release.

When modeling a structure there are situations in which members do
not extend directly between two joints but are instead offset from the
joints. In other situations, the intersection between two members may
be relatively large and can be considered as a rigid link. In all these
instances, the geometry of the model can be specified to more
accurately model the structure by using rigid connections between the
joints and the members. In Multiframe, these rigid connections are
applied using Member Offsets.

Member Offsets are rigid links between a joint and the end of a
member. They are infinitely stiff and do not deform in bending, shear
or axially. Loading on members with rigid offsets is applied to the
flexible portion of the member only (see Member Length on the
diagram below) and distances used to specify the position of loads are
measured from the ends of the rigid offsets.

x1 / Member Length

vyl
z1 y2

Member Offsets

When Member Offsets are specified, Multiframe considers the length of
the member to be the length of the flexible portion of the member.
(Member Length in the diagram above)

To set the Member Offsets on a member

¢ Select the member or members to be modified

¢ Choose Member Offsets from the Frame menu

Member Offzet Connections [ ]
Model——— Mode 2

x  [@@  m X oo m
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& Global  Local [between nodez)

Cancel |

* Click on the radio button corresponding to the axes from which the
offset connections will be measured.

* Type in the size of the offset connections at both ends of the
members.

¢ Click on the OK button
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The size of the offset connections may be specified using global or local
axes. If local axes are selected, the offset connections are measured
relative to the local axes as defined by the nodes at the end of the
members (see Local Axes between nodes below). Note that this is
distinctly different from the true local member axes which are aligned
with the actual position and orientation of a member after the Member
Offset has been applied.

Local Member Axes'

Loca Axes (between nodes) "

Member Offsets are not available in Multiframe2D.

Caution: Results of analyses including Member Offsets can be read
into older versions of Multiframe. This could cause some confusion
as the older version of Multiframe will not recognise the Member
Offsets but will consider the results to be valid.

When modeling structures it is sometimes convenient to define
restraints that are not aligned with or skewed from the global
coordinate system. These types of restraints can now be specified
using the new Joint Orientation feature that has been incorporated into
this version of Multiframe. The Joint Orientation is used to specify an
arbitrary local coordinate system at each joint. This local coordinate
system is then used for applying boundary conditions and loading to
the structure.

All restraints, springs and prescribed displacements that are applied
to a joint are now specified in the local coordinate system. The local
orientation of a joint can also be used for defining joint loads. As with
member loads, joint loads can now be specified in either local or global
coordinates. This is particular useful when working with curve or
cylindrical structures.

The orientation of a joint is specified by 3 angles that measure the
rotation of the local coordinate system from the global coordinate
system. The right hand rule is used to determine the direction of the
rotations. By default, all joints are initially aligned with the global
axes.

To set the orientation of a joint.

Select the joint

Choose "Joint Orientations..." from Frame menu.
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Enter the angles defining the orientation

Press OK

Joint Orientation |
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The orientation of a joint is displayed in the Frame and Load
Windows. If the orientation of a joint is not aligned with the global
coordinates then the axes of the local coordinates are displayed at the
node. An option has been added to the Symbols Dialog to turn off the
display of the local joint axes.

The joint displacements and joint reactions displayed in the Results
Window are now displayed in local joint coordinates. Global results
for each of the displacement of reaction components are displayed in
the tool tips in these tables.

Caution: Multiframe files for structures using local joint loads are not
compatible with older versions of Multiframe. These files may be
read into an older version of Multiframe but analysis of these
structures will cause the program to crash unexpectedly.

The implementation of Joint Linking has been revised so that linked
rotational degrees of freedom now impose rigid body rotation of the
linked joints. As part of this implementation, the user can now specify
the master joint from a list of the linked joints.

Linked Joints ]|

—Jaint Linking:
 Delete Joint Links
& Add Joint Links

M amne:

Master Hode: I a - I

— Linked Dearees of Freedom;
W yooz Bx By Bz

(AR B i I 2

Cancel |

The properties of a linked group of joints can be edited by double
clicking on the group in the Frame window.
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The following restrictions apply to linked joints and the restraints, or
supports, applied to the linked joints.

Joints may be common to several groups of linked joints provided
that the master joint in all of the intersecting groups is the same
joint.

Prescribed displacements can only be applied to linked joints that
are master joints.

Restraints to linked degrees of freedom must be applied to the
master node

The reactions in the direction of the linked degrees of freedom for a
group of linked joint linked are computed at the master joint.

The compliance of the frame to these rules is tested when the user
analyses the frame.

New plots have been added to Multiframe which display moments
about each of the three global axes. These diagrams are useful when
viewing the moments in rectangular frames in which the members are
aligned with the global axes but the orientation of some members is
non-zero. The resulting diagrams show the moments in the members
without accounting for the orientation of the member.

Further plots have been added to Multiframe to display axial tension
and axial compression. Complementary plots showing axial tensile
and compressive stresses have also been added. These plots can be
accessed via the Actions and Stresses sub-menus in the Display menu.

Overlay plots can now be displayed in two colour scales. The original
scale displayed the overlay plot using shades of colour from blue to
red to represent the magnitude of the overlay action. Red represents
large magnitudes while blue is used to signify small magnitudes. A
new colour scale has been added which displays positive values in
shades of red and negative values in shades of blue.

 Overlay Setting:
Dwerlay Action: LColar:
5.084
Precision/Speed: Line Thickness:
© Low/Fast o
& MediumMedium i
" Higher/S lower (o kN-m
" Highest/Slowest (o
) —
Dverlay Color Scal B
© Absolute 1 Sigred
i Diagram Settings
Seale:  [1.000 Cancel |

The user can select the type of colour scale used to display the overlay
plot via the Plot dialog.
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The speed of drawing in the plot window has been improved. This
improvement is most noticeable in the drawing of the displacement
diagrams for which the drawing speed has been improved by a factor
of 4to 5.

The joint reactions from an analysis can now be displayed graphically
within the Plot Window. The reactions are drawn as arrows with the
tail of the arrow scaled according the size of the reaction. A minimum
tail length is enforced so that small reactions are always visible.

A number of options are available via the Symbols Dialog that can be
used to customise the display of reactions. The user can choose to
display either or both the force and moment reactions. A convenient
shortcut button is provided in the Plot Toolbar to turn on or off the
display of these reactions. The Symbols dialog also provides options
for displaying the label associated with each reaction and for shading
the reactions so that smaller reactions are shown in lighter shades of
colour.

Reactions at joints restrained by a Joint Restraints, Spring or
Prescribed Displacement are displayed in the local nodal coordinate
system.

The Members datasheet in the Data Window has been split into the
Member Properties and Member Geometry pages. The Member
Geometry page contains the data describing the size and location of
the members while the Member Properties page contains data
describing properties of the members such as the section types,
orientation and member releases.

A new Geometry menu has been added to the main menu bar. This
menu contains the functions for manipulating the geometry of the
frame including adding, deleting or subdividing members as well as
the functions for duplicating, rescaling and rotating parts of the frame.
These items used to be contained in the Frame menu.

121 ake 127 abe ¥ x4t
JJ—+—+ ——:J-“|I t &

A Symbols toolbar has been added to Multiframe that provides a quick
and simple way to turn on or off symbols such as joint numbers, joint
labels, member number, member labels, section names. A button has
also been included to toggle rendering of the section shapes.

A summation of the reaction components is now displayed at the
bottom of the Reactions datasheet in the Results Window. Only the
three force reactions are summed, moment reactions are ignored.
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When the Section Colours are displayed in the Frame Window, the
names of the sections in the Sections datasheet are drawn in the colour
associated with that section.

Multiframe now allows the user to customise the colours used to draw
many parts of the frame. This includes the colours of the restraint
icons, member axes, clipped members, rendering and even the colour
used to highlight selected members. The colours of these items can be
customised via the "Color..." menu item in the View menu.

Colour Picker |

Lolour: Fendering 1=

B ackground

Clipping
Member Offzets Cancel |

Dezign Members
Jaint Axes
kember Axes
Sechion Axes
Joint Springs
Joint R estraints
Jaoint M azzes I
Labelz

Selection ;I

The colour settings for the action diagrams in the Plot Window have
been removed from this dialog. A separate dialog has been provided
for these colour settings which is accessed via the "Plot Colors..." item
in the Display menu.

All Multiframe users are familiar with the rectangular selection tool
used to select multiple members within a region. A new line selection
tool has been added which allows the user to drag a line across the
screen. All members intersecting this line will be selected. The user can
swap between the rectangular and line selection tools using the
buttons added to the View toolbar.

A new option has been added to the Import menu to insert an existing
Multiframe structure into the current frame.

Multiframe can evaluate mathematical expressions in some dialog
fields and in the CalcSheet Window. Some new functions have been
added to this facility for evaluating arc tangents, arc sines and arc
cosines. The ATAN function evaluates the arc tangent of a number and
returns the angle in degrees. This compliments the existing ARCTAN
function that evaluates the arc tangent in radians. The ASIN and
ACOS functions compute the arc sine and arc cosine of a value and
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return the angle in degrees. ARCSIN and ARCCOS functions have also
been added which return the resulting angle in radians.

These new functions are useful for setting the Joint Orientation or
Member Orientation based on the position of the joint or member. See
the example later in this release note.

In certain dialogs that act upon joint loads, restraints or the properties
of a joint, Multiframe can evaluate expressions that include variables
representing the coordinates of a joint. These variables are as follows:

Variable  Description Units

X x coordinate of joint Length
Y y coordinate of joint Length
V4 z coordinate of joint Length

When the dialog is accepted, each joint in the current selection is
considered in turn, the above variables substituted by the location of
the joint, and the appropriate values set for the load, restraint or joint
property. The following dialogs currently support parsing these
variables:

Joint Spring dialog

Joint Displacement dialog

Joint Orientations dialog

Joint Load dialogs

Joint Moment dialogs

Dynamic Load dialog

Most users would be familiar with the ability of many dialogs within
Multiframe to interpret the letter "L" as the length of a member.
Multiframe can now evaluate expressions that contain variables that
represent the geometric properties of a member or it's section
properties. These variables include:

Variable  Description Units

L Length of member Length

X1 x coord of joint at start of member Length

Y1 y coord of joint at start of member Length

Z1 z coord of joint at start of member Length

X2 x coord of joint at end of member Length

Y2 y coord of joint at end of member Length

z2 z coord of joint at end of member Length

B Width of section Displacement
D Depth of section Displacement
Tt Flange thickness Displacement
Tw Web thickness Displacement
A Area of section Area

theta Member Orientation radians

In addition, the section properties as described in the CalcSheet section
of the manual can also be evaluated. When a dialog is accepted, each
member in the current selection is considered in turn, the above
variables are substituted by the appropriate value, and the expressions
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evaluated before setting the value of field. The following dialogs
currently support parsing member variables:
- Member Offsets dialog

Member Orientation dialog

All Member load dialogs

Bending dialog (SteelDesigner)

Tension dialog (SteelDesigner)

Compression dialog (SteelDesigner)

Constraints dialog (SteelDesigner)

Consider a circular beam shown below that lies in the x-y plane with
it's centre at the origin. A simple technique for applying Joint Loads
which are perpendicular to the beam is to set the orientation of the
joints along the beam so that the local x' axes are aligned away from
the origin. Loads on the joints can then be applied as Local Joint Loads
which will be aligned with the local joint axes.

y y

L., L., -

The orientation of all the joints can be set together using Multiframes
capacity for evaluating expressions containing nodal variables. To set
the orientation of all the joints so that the local x' axes points directly
away from the origin:

Select all joints along the curved beam.

Choose "Joint Orientation..." from the Frame menu.

Enter ATAN(Y/X) in thefz field

Press OK.

Joint Orientation |

— Az Orignkation
Ax
By

Az IﬂT:’-‘-.N [/
(] I Cancel I

IEI.EIEI deg
IEI.EIEI deqg
deqg

Y

Multiframe computes the angle for each joint in the selection by
substituting the corresponding joint coordinates for X and Y. Similar
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expressions can also be used to orient a joint to any point. This is
particular useful when working with cylindrical or curved structures.

The Report Window is now activated within Multiframe as all times. It
was previously only displayed when Steel Designer was running.

The matrix solver at the heart of Multiframe analysis engine has been
further optimised to reduce analysis times. A reduction in analysis
time of up to 40% has been experienced for linear analyses. For
nonlinear analyses, reductions of up to 60% have been recorded.

Convergence and iteration data from a nonlinear analysis is now
output to the Report Window. This data includes the displacement
and force norms at the end of each iteration as well as warnings and
error messages in relation to the analysis. The amount of information
output during a nonlinear analysis can be specified via the Analysis
dialog which now includes options to specify the reporting level for an
analysis as either None, Brief or Detailed.

Steel Designer

The following features have been added to Steel Designer in this
release.

To improve the design capabilities of Multiframe we have added
Design Groups. A design group is a series of connected members that
can be considered as a single member for design purposes.

Before a group of members can be included in a design group and then
used for design the following conditions must be met

- All members must be connected with the local x” axis facing
the same direction

- All members must have the same section type

- All members must have the same orientation

- All members must be rigidly connected internally (end may be
released)

- All members must be approximately co-linear

- Members may have rigid offsets at internal joints but the
flexible portions of the members must be continuous within the
design group.

- There must not be any restraints on the internal connecting
nodes

Group Memberz Clrl+G

IIngroup kMembers
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Members can be combined into design groups in the Frame Window.
To create a design group,

Select the members to be grouped
Choose "Group Members" from Design menu.
or

Press Ctrl+G

Note that the members to be grouped must satisfy the rules described
above. The new design group is given a default label of “D” + the
number of the group.

To break up design groups, select members that are part of the group(s)
and choose "Ungroup Members" from the Design menu.

To distinguish design groups from the individual analysis members, a
separate numbering system is adopted where every member has its
own design group number at creation. Conceptually each member is a
design group of one. When members are grouped into a multi-member
design group the design group numbering is modified to reflect the
reduced overall number of design groups.

The design group numbering is used in both the Design Details and
Design Efficiency data tables.

« Data =] E3
De=sign Group Members Label Section
1 1 S6,49 3423121 [y Foug40.4
2 2 2 Foug40.4
3 3 55,47 5625143 [ Foug40.4
4 4 4 Foug40.4
= g 60,4958 27 165 (] Foug40.4
= G G Foug40.4
7 7 7 Foug40.4
g g g Foug40.4
) | 4 JoJp404 T
4 [ v [£ Analysiz Settings 3 Design || 4] | 2

When a member is double clicked in the Frame window and that
member is part of a design group, the details for the entire design
group are available to be edited, rather than for the individual member
clicked on.
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Design Group 1 Properties |
Steel Grade I Conztraints I Serviceability

Member | Bending I Tenzion I Compreszion
— eametm

tembers: B6.45.34.2312.1

Length f30.000 m

Slope f0.000 deg

Qrientatian Im deg
— Sechion

Group I LE j

Section |3100B40.4 =]
— Label

D1
] I Cancel

Note that the Length and Angle fields are disabled as you are not able to edit
these directly for the entire design group.

To edit the details for an individual member, select the member and
then select the "Member Properties..." item from the right click popup
menu.
Joint Bestraint. ..
Joint Type. .
Joint Labels...

Section Type...
Section Grade. ..

Member Releazes. ..
tember Orientation...
kember Tupe. ..
bember Labels...

Bending...
Tenszion...
Comprezsion...
[Eambimed.,.
Serviceability...

[Eromm embens [t
Ungroup Members

Member Properties. ..
Dezign Group Properties...
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Viewing Results Using
Design Groups

In the plot window if you click on a member that is part of a multi-
member design group, you will get a local member view that includes
all the members in the design group. The details of a single member
within this group can be examined by simply clicking on a member
within the diagram.

» Plot _ (O] X]

o d|eo|ss

Mz’
4

Wit
4

oy
41
Mz -2.885 kM-m 1
bt -5824 kM =
oy -35. 060 mm
Dist 15.000m 41
hetmber 34

Static Case: Load Case 1 Design Group 1 (017 310UB40.4

Design Group Symbols
In the Symbols dialog there are three check boxes dedicated to viewing
design groups.

Dezign Graup
¥ Design Groups

[ Mumbers

If Design Groups is checked then multi-member design groups are
displayed in the Frame window by a patterned blue overlay.

If Labels is checked the labels of the multi-member design groups are
displayed in all the drawing windows.

If Numbers is checked the numbers of all the design groups used in
design are displayed in all the drawing windows.

Rendering of Design

Groups
Design groups with more than one member are rendered in the Frame
and Load windows as a single member.
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When Checking or Designing members you are now actually working
with Design groups. So if you select a member that is part of a multi-
member design group then the Check/Design will be carried out on
the design group.

This is reflected in the reporting which will display the design group
number being check and below it the member(s) that make up that

group.

Checking Design Group 1 (D1)

Members: 34,23.12.1

Group: LB
Section: 310UB40.4

Compute section properties

The location and type of lateral restraints can now be displayed
graphically in the Frame and Plot windows. The display of lateral
restraints can be turned on or off via the Symbols Dialog which now
contains options for displaying lateral restraints and labeling these
restraints.

The restraints are draw as a short line in the plane of the major axis of
the member. These lines extend each side of the member for a distance
that is roughly the scale of a purlin or girt. Lateral restraints are also
displayed in the rendered view of the frame in which they are draw to
extend from each flange by approximately the size of a purlin. The
restraints may be labeled using a one or two letters to indicate the type
of restraint (e.g. F - fixed, P - partial).

Note that lateral restraints at the end of a member are draw slightly
offset from the node so that restraints at the ends of connected
members may be more readily distinguished.

The governing load case associated with the design of a member is
now recorded when designing or checking a member. The governing
load case associated with each member is displayed in the Efficiency
Datasheet.

The governing load cases associated with each of the individual
design checks are also stored as part of a design. The governing load
case for a particular design check is displayed as a cell tooltip in the
Efficiency Datasheet or as a member tooltip in the Plot Window when
a plot of the efficiency is displayed in the PLOT window.
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The implementation of constraints has been modified so that any
design requirement that is not dependent upon the design actions can
be testing independently of the load cases. The concept of Design
Constraints is now used to encompass the existing constraints that
can be imposed upon the dimensions of a member as well as any
constraints that may be imposed by various design checks. (L.e. a
slenderness check that may be required as part of a bending design).
For most of the design codes no additional constraints have been
added and the only Design Constraints will be the constraints on the
size of the member. For the AlJ design code, a check on the
Width/Thickness ratio of the section is performed with several of the
design checks. Design Constraints are applied when Designing and
Checking a member. Previously, the constraints on the size of a
member were only applied when Designing the member.

The calculations associated with Design Constraints are output to the
design report. These calculations are performed at the start of the
design before considering the design checks for each load case. When
using Brief Reporting, the calculations for failed design constraints are
output to the report. With detailed or full reporting, the calculations for
all Design Constraints are shown in the report.

The status of Design Constraints which were tested when Designing
or Checking a member are displayed in a new "Constraints" column in
the Design Efficiency datasheet. If no constraints were checked for a
particular member, a dash is shown is this column. Otherwise, this
column displays the number of Design Constraints that were not
satisfied as part of the design.

Section Maker

The following features have been added to Section Maker in this
release.

A column has been added to the Sections Window that displays the
colour associated with section. Double clicking over a cell in this
column allows the user to select a new colour using the Colour Picker
dialog. The colours in this column may be cut and pasted or
duplicated to other sections using the fill down option.

Problems Fixed

This version fixes the following problems experienced with previous
versions of Multiframe, Steel Designer or Section Maker.

Drawing of Tension/Compression only members in
Displacement diagram.

Analysis of Tension/Compression only members sometimes
failed to converge when analysing multiple load cases.
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Deflection checks in Steel Designer are now performed using
local deflections measured relative to displaced position of the
members end.

In Steel Designer, design actions about the major and minor
axes of the member were switched when using Multiframe2D.
This only occured for members with non-zero member
orientations.

Incorrect behaviour of Size to Fit in 3D views.

Spurious messages when duplicating joint loads and
restraints

Section colours set in Multiframe are now saved to section
library

Incorrect load cases names used for nonlinear results when
designing to ASD or AlJ design codes

Action diagrams for Tension/Compression only elements
with applied loads are now computed correctly.

Problem Reports

We greatly appreciate the bug reports and suggestions we have had so
far, please keep them coming. Please continue to report any bugs or
anomalies you find:

Fax: +61 8 93351526 Email: support@formsys.com

You can also lodge your problem reports via our web site at the
following location:

http:/ /www.formsys.com/Multiframe/MFSupport/ MFProblemRepor
thtml




